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1. Downloading your Examination Paper 
Option 1 & 2 examinations 

Examination papers for Option 1&2 examinations can be found at University of Exeter Exams ELE. 

The site will look just like ELE, so navigate to your module page as you would in ELE.  

On your module page, you will find your examination paper along with any specific instructions. Click on the 
examination paper link to download it, and save the examination paper to your hard drive. For option 2 
papers, your exam time will start when you click on the ‘Attempt quiz now’ button. As soon as you open the 
quiz your start time will be logged and the duration of your exam will begin. Please make sure you are ready 
and have everything you need before you click on the quiz. You will then be taken to a page to download 
your examination paper. Please close ELE once you have downloaded your examination paper. 

For Option 1 examinations, you must submit your paper within 24 hours of the release time. For Option 2 
examinations, you must submit your paper within the total completion time: this includes the academic 
writing time specified on your rubric, plus any Individual Learning Plan (ILP) time if applicable, plus 30 
minutes of upload time.  

Option 3 assessments 

Option 3 assessments will be on your usual module page on ELE. 

If you have any problems finding your paper contact the Assessment Helpdesk on (+44) 01392 726800. 

2. Uploading your Examinations 
When undertaking Option 1 examinations or Option 3 assessments, aim to submit your completed work a 
minimum of 20 minutes before the submission deadline to give you time to resolve any problems you 
encounter in the submission process. When undertaking Option 2 examinations that have a fixed duration, 
you have been allocated an additional 30 minutes of time for this purpose, in addition to your actual 
examination time. This additional 30 minutes is there to support you with your submission process should 
you experience any technical difficulties. Please do not use this time to continue working on your answers. It 
is your responsibility to ensure that the correct document is uploaded before the end of your examination 
time window, and to monitor your time to allow you to do so.  

If you have any problems during your examination you can contact the Assessment Helpdesk on (+44) 01392 
726800.  

The Assessment Helpdesk will operate at the following times:  
• From 8am to 8pm Monday to Friday and 8am to 12.30pm Saturdays British Summer Time (BST). 

 
Additionally, the Helpdesk will have extended hours on the following dates to account for weekend 
examinations:  

• Saturday 16th and Saturday 23rd May: 8am - 8pm  
• Sunday 17th and Sunday 24th May – 8am – 1230pm 

 
If necessary, the Helpdesk will escalate issues to the nominated academic module point of contact. Please do 
not contact your module lead (or another module tutor) direct during your examination.  

Where possible please ensure you have a secure, strong internet connection before submitting online. 

https://exams.exeter.ac.uk/
https://vle.exeter.ac.uk/
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If you handwrite all or parts of your assessment we recommend that you scan or photograph your work using 
a smartphone camera, digital camera or equivalent device - you can only submit a single PDF into BART 
therefore the hand written content must be scanned or photographed and then inserted into a single 
document before saving as a PDF. 

There are numerous mobile applications which can help you do this, but the simplest method is to 
photograph your work using your phone camera. Hold your phone over your work and make sure that all of 
it your work is in the image. Propping your elbow(s) on the table may help to steady the hand(s) holding he 
camera. You may also find it useful to have the flash turned on or off, depending on the room lighting and 
the make/model of your device. Ensure that the content is in focus, and capture the picture. It is advisable to 
practise doing this in advance. 

Once taken, transfer the image(s) to your computer and insert the image(s) into your examination 
submission document. If you have an iPhone you can scan documents directly into the Notes app and then 
copy them into your work – further information is available on the Apple support site on how this works. 
Similar functions may be available for other devices, so please check for guidance online in advance of your 
examination.  

Before saving your assignment into PDF format check that you are using one of the recommended PDF 
writers (see Section 5). This is important to ensure that your examination is saved correctly. You can use 
other PDF writers but you will need to check that you assignment submits correctly in BART. 

Please note your PDF file size must be below 50MB (see Section 5.8).  

 Note: PDF files are generally much smaller than Microsoft Word files. 

If you have followed all formatting requirements and the file upload still fails, try converting your original file 
again using a different recommended PDF writer. 

If you wish to re-save your PDF file, go to your original MS Word file and re-save the MS Word file as a PDF. 
Do not re-save the PDF file in Adobe reader or equivalent as the file will be rejected by BART. 

If saving a PDF attachment from an email, right click and ‘Save As’ to ensure the document saves correctly. 

PLEASE NOTE Any student can apply for mitigation should you experience technical issues or IT 
failure during an examination. Requests must be received either before the examination or within 
24 hours of sitting. 

 

  

https://support.apple.com/en-us/HT210336
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3. Formatting requirements checklist 
 

BEFORE YOU SUBMIT please review the format checklist below. If your paper meets all of the criteria, then 
you will be ready to submit (see Section 4). 

 

 

  

Check Yes No 

PDF format - Is your paper saved 
in PDF format using one of the 
recommended PDF writers?  
 
Recommended PDF writers:  
 
• Microsoft Word 2007, 2010 & 

2013 or later 
• Mac Office 2008 & 2011 or 

later 
• PDF Creator 
• CutePDF.com 

 

OK for 
submission 

Please re-save your work using one of the 
recommended PDF writers (see Section 5).  
If you do not use one of the recommended PDF 
writers we cannot guarantee your submission will be 
formatted correctly. 
 

A4 format – Is your paper saved 
in A4 format? 

OK for 
submission. 

Please re-save your work in A4 format. A3 etc files 
will not be accepted. 

File size - Is your file size below 
50MB? 

For information on how to check 
your file size, see Section 5.8 

OK for 
submission 

Please reduce your file size in the software you are 
using to complete your examination. If your file 
contains pictures you can compress these using the 
‘compress pictures’ button on the tools/format bar 
in MS Word (see section 5.9) 

If you cannot reduce your file size please contact the 
Assessment Helpdesk on (+44) 01392 726800.  

Single file – Is your paper in one 
single file?  

OK for 
submission 

Combine all your separate files into one single file, 
making sure they are in the right order so the 
marker can navigate your answers. Then recomplete 
the format checklist.  

Font - Have you used the correct 
font size and style specified in 
any examination instructions? 

OK for 
submission 

Please change your font to the required size and 
style. 
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4. Submitting Online 

4.1. LOCATING YOUR EXAMINATION 
 

STEP 1:  Log into BART. 

 

STEP 2:  Locate your examination (assessment item) from the schedule list. There will be a click-button beside 
it saying Submit Online (see Figure 2).  

 

4.2. UPLOADING YOUR EXAMINATION 
 

STEP 3:  Click on the ‘Submit online’ button. This will take you to a ‘Submit assignment online’ screen (see 
Figure 3 below). 

FIGURE 2 

https://bart.exeter.ac.uk/
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FIGURE 3

 

STEP 4:  Input the relevant details into the boxes provided. Please check the rubric on your examination to 
see if a word count is specified. If it is, please enter the word count of your paper. If it isn’t, please enter a 
zero in this field: successful completion relies on a number being entered in this field.  Then select your 
assignment by clicking on the ‘Choose file’ button. 

STEP 5: A pop-up ‘Open’ dialogue box will appear (see Figure 4). Select the document you wish to upload and 
click ‘Open’.  

 

 

 NOTE: Please ensure your file complies with the formatting requirements checklist (see Section 3) 
otherwise your submission may be rejected. SUBMITTING YOUR EXAMINATION 

STEP 6: Once you have selected and opened your file, click on the ‘Submit Assignment’ button. Please be 
patient, it may take a few minutes for your submission to upload to BART. If there are any issues with the 
system we will let you know by email on the day of your examination. 

 

Figure 4 
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STEP 7: A submission confirmation message, ‘UPLOAD COMPLETE!’, should appear on your screen showing 
your electronic submission receipt (see figure 5 below). BART will automatically add your name and student 
number to your submission. 

 

You will also have the option to view your submitted examination by clicking on the ‘View final submission 
with cover sheet’ link. 

 NOTE: It is your responsibility to ensure that the correct document has been uploaded before the 
submission deadline 

 NOTE: If you submit your assignment before the submission deadline, you will have the option to 
resubmit your assignment, so long as you do so before the submission deadline. See the 
‘Resubmission Section’ below. 

 NOTE: Your cover sheet will have been added to your submitted document when you view it. 
 NOTE: You will have the option to view your assignment at any time after you have submitted it (see 

Section 4.4) 
 NOTE: You do not need to go back in to ELE to click ‘finish’ on your assessment. ELE timestamps the 

start of your examination and BART records the finish time 

STEP 8: You should also receive a BART receipt via your University email account confirming receipt of your 
submission (see Figure 6). You should check your University email to make sure that you have received a BART 
receipt.  

 

Figure 5 
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 NOTE: If a submission confirmation page appears on your screen but you do not receive an email 
receipt, please contact the Assessment Helpdesk on (+44) 01392 726800 to check that your submission 
has been successful. 

 NOTE: You can also check whether your assignment has been submitted by looking at your BART 
schedule which will have the time and date of submission beside your assignment (see Figure 2). 

4.3. VIEWING YOUR EXAMINATION 
 

STEP 9: You will have the option to view your uploaded examination file at any time after you have submitted 
it. On your BART schedule, a button option will appear beside your assignment labelled 'View submission' (see 
Figure 7 below). Click on this to view your assignment.  

 

4.4. UPLOAD FAILED PAGE 
 

If your assignment submission is not accepted, an ‘UPLOAD FAILED!’ page will appear on your screen (see 
below).  It will have 1 of 4 messages underneath stating possible reasons for the failed upload.  

If you have a problem uploading a PDF using Firefox, please try a different web browser such as Internet 
Explorer or Chrome. It may be useful to ensure two or more of these are accessible to you in advance of the 
examinations.  

a) File size  

 

Figure 6 

Figure 7 



9 
 

 
For more information on how to reduce you file size, see Section 4.9 

b) PDF format 

 

 
For more information on saving PDFs, see Section 4 

c) Formatting 

 

For more information on formatting requirements, see Section 2.  
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d) Resaving PDF 

 

For more information on re-saving PDFs, see Section 5.7 

You should follow the instructions on the UPLOAD FAILED page and re-check that you have complied with all 
the formatting requirements listed at the beginning of this document (see Section 3) and then try submitting 
your examination file again following steps 1-8.   

If you have followed all formatting requirements and the upload still fails, try converting your original file again 
using a different recommended PDF writer. 

If your examination is still not accepted, please contact the Assessment Helpdesk on (+44) 01392 726800 for 
further assistance.  

4.5. RESUBMISSION 
 

You have the option to re-submit your examination as many times as you wish before the submission deadline.  

To re-submit, log into BART and locate your assignment again on the BART schedule.  

There will now be a button labelled ‘Re-submit online’ (see Figure 8).  

 

 

Click on the ‘Re-submit online’ button. This will take you to a ‘Re-submit assignment online’ screen (see Figure 
9). 

 NOTE: The new assignment you submit will overwrite your previously submitted assignment. 
 

  

Figure 8 
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Figure 9 
 

 

Now follow the steps in Section 4 again as if you were submitting for the first time ensuring that you have 
complied with the formatting requirements (see checklist, Section 3).  

When you click on the ‘Submit assignment’ button a warning message will appear reminding you that your 
new submission will overwrite your previous submission (see Figure 10). If you are happy with this click the 
‘OK’ button. If not, click the ‘cancel’ which will take you back to the ‘Re-submit assignment online’ screen. 

 

 
 NOTE: If the submission deadline has passed and you have already submitted an assignment, you will 

not be able to re-submit your assignment. The ‘Re-submit online’ button in the ‘Online submission’ 
column on your BART schedule will have been replaced with the message ‘Deadline past’. 

 
 

  

Figure 10 



12 
 

5. How to save your examination in PDF format (including 
recommended PDF writers) 

 
 

5.1. MICROSOFT WORD 2010 
 

• Open your examination submission file in Microsoft Word. 
• In the File tab, click on Save As in the Navigation pane. Then, in the Save As dialogue box, access the 

Save as type drop-down menu by clicking on the little arrow (see Figure 11 below). 

 

 

  

Figure 11 

Select your desired location for saving the 
document here 

Access the drop-down 
menu by clicking the 
little arrow 

Select  
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• Select ‘PDF (*.pdf)’ 
• Select your desired folder location  

 

 

•  Now click the ‘Save’ button. 

5.2. MICROSOFT WORD 2013 
• Open your examination file in Microsoft Word. 
• Click on the File tab, select a file location in the main pane (e.g. Desktop) (see Figure 13).  

 

 

  

Figure 12 

Figure 13 
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• This will bring up a ‘Save As’ dialogue box (see Figure 14).  

Check the file location in the address bar at the top of the dialogue box. If required, you can change this 
location by selecting an alternative from the drop-down menu. (Access the menu by clicking on little black 
downward-pointing arrow at the end of the bar.) Next select PDF (*.pdf) from the Save as type drop-down 
menu. 

   

Figure 14 

Figure 15 
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• Now click the ‘Save’ button (see Figure 15).  
• Now click the ‘Save’ button (see Figure 15). Your file will now be saved as a pdf file in your chosen 

location. 

5.3.  MAC 2008/2011 
• Open up your file in Microsoft Word. 
• Click on the ‘File’ tab and then ‘Save As’ in the navigation pane. 
• A dialogue box will appear (see Figure 16). 
• Select PDF from the format drop-down menu 
• Select the desired folder location and then click ‘Save’.  

 

 

 

  

Figure 16 
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5.4. PDF Creator 
• Open up your file in Microsoft Word. 

 

• Click on ‘File’ tab and then ‘Print’ in the navigation pane (see Figure 17). 
• In the drop-down menu under ‘Printer’ select ‘PDFCreator’.  
• Click on the ‘Print’ button. 
• A ‘PDF Creator’ dialogue box will appear (Figure 18) 

 

• Click on ‘Save’  

 

Figure 17 

Figure 18 
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• A ‘Save as’ dialogue box will now appear (Figure 19).  Select the desired folder location from the drop-
down menu and click ‘Save’.  

 

 

 

5.5. CutePDF 
• Open up your file in Microsoft Word. 
• Click on the ‘File’ tab and then ‘Print’ in the left hand column. 

 

 

 
• In the drop-down menu under ‘Printer’ select ‘CutePDF’ (see Figure 20) 
• Then click on the ‘Print’ button 

 

Figure 19 

FIGURE 20 
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• A ‘Save As’ dialogue box will appear (see Figure 21) 

 

 

• Select the desired folder location and click ‘Save’.  
 

 NOTE: CUTE PDF website  
 NOTE: Assignments converted to pdf file format using PrimoPDF creator will NOT upload 

5.6. SAVING A PDF FROM AN EMAIL 
 

When opening a PDF attachment from an email, ensure that you save it in the correct pdf format. To do this, 
right click on the file and then select ‘Save As’ (see Figure 22) - rather than double clicking on the attachment 
to open and then save the file.  

 

5.7. DO NOT re-save PDFs 
Once you have saved your file as a pdf, please do not re-save the pdf as the file will be rejected when it is 
uploaded.  
 
If you want to make changes (e.g. save the file with a different file name), please make the changes to the 
original Word file and then re-save the updated Word file as a PDF. Do not re-save the PDF itself in Adobe (see 
Figure 23). 

 

Figure 21 

Figure 22 

http://www.cutepdf.com/
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5.8. CHECKING YOUR FILE SIZE 
To check your file size of a PDF click on ‘File’ and then select ‘Properties’ from the drop down list (see Figure 
27). 

 A pop-up ‘Document Properties’ dialogue box will appear (see Figure 24). The file size of your pdf will be 
shown here under ‘File Size’.  

 

 

  

Figure 23 

DO NOT select the file and 
click on ‘Save As’ to re-save 
your pdf. Close the pdf, go 
to your original Word file 
and re-save this as a pdf.  

Figure 24 Figure 25 
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5.9. REDUCING YOUR FILE SIZE 
NOTE: Make sure you have checked your file size once it is in PDF format. PDF files are generally much smaller 
than MS Word files. 

Compressing pictures 

If you have images in your assignment Word document, you can reduce your file size by compressing these 
images.  

Click on the image in your MS Word file and then in the ‘Format’ tab of ‘Picture Tools’, select ‘Compress 
pictures’ (see Figure 25). 

 

 

 

 

A ‘Compress Pictures’ dialogue box will appear (see Figure 26).  

Under the ‘Change resolution’ Section select ‘Print’.  

Under the Section ‘Apply to’ you have the option to apply this to ‘All 
pictures in document’ or only ‘Selected pictures’.  

Once you have chosen your desired settings click ‘OK’. 

Convert your MS Word file to a PDF and then re-check your file size (see 
Section 4.8) 

 

Remember, if you have any technical problems during your examination you can 
contact the Assessment Helpdesk on (+44) 01392 726800. 

Figure 26 

Figure 27 
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